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Using OpenOffice.org Writer  

This  article  was  originally  published  on  Free  Software  Magazine 
(http://www.freesoftwaremagazine.com) under the title “The Lazy User's Guide to 
OpenOffice.org Writer” and is reproduced in conformity with the licence granted 
by  the  author,  Daniel  Escasa,  (Attribution-NonCommercial-ShareAlike  2.5  – 
http://creativecommons.org/licenses/by-nc-sa/2.5/)

Create and manage large documents

All hail the lazy, for they will find the most efficient way to 
work  a  computer  in  general,  and  a  word  processor  in 
particular. In this article, I’ll look at three lazy writer’s tricks 
that  can  relieve  you  of  most  of  the  drudgery  involved  in 
creating  a  fairly  large  document  in  OpenOffice.org  Writer 
(henceforth, OOo Writer or simply Writer).

Make the computer do most of the work

A word processor such as Writer is “bloated” for a reason—it 
has features that save you a whole lot of work. Of course, 
masochists or uber-workaholics might hate these features, but 
the lazy user can’t imagine life without them.

These are the three things I’ll show you how to do:

• create a title page, 
• create a table of contents, 
• and change the page numbering styles 

...the lazy way, of course.

Creating a title page

I’ll create a title page where the title lands in the middle of 
the  page.  This  title  page  might  also  include  author 
information—either just below the main title, or right at the 

1

Figure 1: Centering the title
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bottom of the page.

Start with a blank page. If you’re adding a title page to an 
existing document, you’ll have to insert a new page before 
the first one. If you were workaholic or masochist, you would 
then  type  in  the  title,  set  its  character  and  paragraph 
attributes, then hit the Enter key until it “looks” centered.

Masochists  or  uber-workaholics  might  hate  these  features, 

but the lazy user can’t imagine life without them But you’re 

lazy and more sensible. So, you draw a text box anywhere on 
your blank page—its size doesn’t  matter,  because you can 
always adjust it later to fit your title. Use Insert→Frame 
to do this, type your title into the text frame, then resize as 
necessary.

Once you’re happy with your title, you’re ready to center it 
on the page. Right click on the text  frame, select  Frame, 
then  choose  Center from  the  Horizontal drop-down 
list, then Entire page from the  to drop-down list. Also 
choose  Center from the  Vertical drop-down list,  and 
Entire page from its  corresponding  to drop-down list 
(as shown in figure 1).

This should give you some idea of how to place an author 
frame at the bottom right of the page, which I will leave as an 
exercise for the reader.

Creating a table of contents

Once your  document  is  long enough—say,  upwards of  10 
pages—it may be time for a table of contents to help your 
reader out. You can create a table of contents from an outline 
of your document, or from paragraph styles that you select—
e.g., Heading or Heading 1. With Writer and, I suspect, MS 
Word  and  other  modern  word  processors,  you  can  create 
hyperlinks  to  your  outline.  So,  when a  reader  clicks  on  a 
section  heading  in  the  table  of  contents,  the  program will 
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Figure 2: A sample table of contents



move the cursor to that heading. For instance, if you click on 
the text “Planning the Migration” in figure 2 (take note that 
it’s got a blue underline), Writer will move to Chapter 5—
which just “happens” to be titled “Planning the Migration”.

While I’m on the subject of outlines, you’ll notice that the 
sections and subsections are numbered. Again, I told Writer 
to put those numbers in. The cool thing about it is that if I 
insert  a  level-one  outline  item (say,  between  “Degrees  of 
migration” and “Planning the migration”), the latter will be 
renumbered 5, and its sections 5.x and 5.x.y. Even cooler is 
that  it’s  not  that  hard  to  create  a  numbered  outline—
Tools→Outline Numbering did it. That’s just a bit of 
setup upfront to save tons of manual work.

To create the table of contents, first move the mouse cursor to 
the start of the document,  then  Insert→Indexes and 
Tables,  then click on  Indexes and Tables.  Below 
the  Create from pane,  check  the  Outline box,  then 
click on the ellipsis (...). The Outline Numbering dialog 
box should come up (figure 3). Select 1-10 and click OK. 

If you want to create hyperlinks, click over to the Entries 
tab, click on the empty box to the left of the E and click on 
Hyperlink,  then click on the empty box after the  E and 
click on Hyperlink again. Click OK to create the table of 
contents. 

The computer can do so much for us if we only let it. I should 
mention that Writer doesn’t automatically update the entries 
in the table of contents. If you inserted a new section between 
5 and 6, for instance, or typed in enough text in section 5 to 
cause  a  page  renumbering,  the  table  of  contents  wouldn’t 
reflect the changes. Not to worry, Writer will do it for you, 
you just have to ask nicely—just right-click anywhere within 
the table of contents, then click Update index/table.
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Figure 3: Setting up the table of contents



Changing page numbering style

A long document’s preface or foreword will come after the 
Table of Contents and its pages numbered with lower-case 
Roman numerals (i, ii, iii, ...). After that comes the main body 
of the document,  numbered with Arabic numerals (1, 2, 3, 
...). 

Here’s how to do it.

First,  insert  a  new page.  Use  Insert→Manual Break 
(as shown in figure  4), then  Page Break, and be sure to 
change the  Style to  Default. You can’t use the  Ctrl-
Enter keyboard shortcut  because  if  you do,  you’re  stuck 
with the No Style option. Also set the page number to 1.

We should learn more about what our software can do for us 
so we can apply our hard work to things that really matter.

Next, format the page so that page numbers are lower-case 
Roman numerals: select the  Page tab and select  i, ii, 
... from the Format drop-down list (as shown in figure 5). 

Also  make  sure  that  either  your  Header  or  Footer  is  on 
(depending  on  where  your  page  numbers  should  be)  by 
clicking on the appropriate tab and checking the relevant box. 
Type in your preface.

When you’re done with the preface, it’s time to go back to 
Arabic numeral  page numbering:  force another  page  break 
with Insert→Manual Break, then Page Break, and 
be  sure to  change the  Style to  Default,  and the page 
number to 1. Also set the page number format to 1, 2 ....

Conclusion

The computer  can  do  so  much for  us  if  we  only  let  it.  I 
believe we work too hard at times, taking 20th or even 19th 
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Figure 4: Inserting a page break



century  habits  into  the  21st.  We  should  learn  more  about 
what our software can do for us so we can apply our hard 
work to things that really matter.

Source URL:

http://www.freesoftwaremagazine.com/articles/the_lazy_user_s_
guide_to_openoffice_org_writer 

Index

Learn Firefox and more

From  the  Shelly  Cashman  Series,  the  State  Library  has 
Mozilla Firefox – Introductory Concepts and Techniques. It 
is published by Thomson Course Technology and is a student 
manual  and  workbook.  Co-authors  are  Gary  B.  Shelly, 
Thomas  J.  Cashman,  Steven  G.  Forsythe  and  Steven  M. 
Freund. It comes complete with a CD on which are Mozilla 
Firefox and Mozilla Thunderbird.

Despite  the  title,  the  book  is  about  much  more  than  just 
Firefox,  dealing  with  email  (using  Mozilla  Thunderbird), 
research using search engines and other aspects of Internet 
life. 

It is divided into three projects. The first is  Introduction to 
Firefox, the second is Web Research Techniques and Search 
Engines,  and the third is  Communicating over the Internet  
using Mozilla Thunderbird. There is also a special feature on 
open  source  concepts  and  customising  Firefox,  as  well  as 
three  Appendices  covering  installation  of  Firefox  and 
Thunderbird, and setting Firefox options. Finally there is  a 
quick  reference  summary.  The  projects  take  the  student 
through various activities in an easy to follow manner and I 
highly recommend the book to anyone interested in Firefox 
and, to a lesser extent, Thunderbird.

Index
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Figure 5: Setting the preface page numbers
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Ubuntu base for Linspire/Freespire

Of late there has been a trend for Linux distributors to co-
operate.  Several  Debian-based  distributions  were  given  a 
standard  core  a  while  back  and  last  month  Linspire  and 
Canonical (Ubuntu) made an announcement about future co-
operation, with Linspire basing its distro on Ubuntu, rather 
than directly on Debian. In this it is not alone, with about two 
dozen distros now using Ubuntu as their source (not counting 
Ubuntu  with  different  desktops,  such  as  Kubuntu  and 
Xubuntu).  Ubuntu,  for  its  part,  will  incorporate  Linspire's 
CNR  technology  so  that  they  can  sell  commercial  Linux 
applications with the ease of click, buy and install online.

Here's the text of the joint announcement from Canonical and 
Linspire:
 
LONDON & SAN DIEGO, February 8th, 2007 – Canonical  
Ltd,  the  lead  sponsor  of  the  popular  Ubuntu  operating 
system, and Linspire, Inc. the developer of the commercial  
desktop  Linux  operating  system  of  the  same  name,  
announced plans for a technology partnership that integrates 
core competencies from each company into the other's open 
source Linux offerings. 

Linspire will transition from Debian to Ubuntu as the base  
for their Linspire and Freespire desktop operating systems. 

This will mean that Linspire users will benefit from Ubuntu's  
fast moving development cycles and focus on usability. The  
Freespire  community  will  start  seeing  early  releases  of  
Freespire 2.0 based on Ubuntu in the first quarter of 2007,  
with the final release expected in the 2nd quarter of 2007,  
following the official release of Ubuntu 7.04 in April. 

"Ubuntu  is  the  most  successful  community-based  Linux 
project  to  date,"  said  Kevin  Carmony,  CEO  of  Linspire.  
"They  have  done  a  fantastic  job  with  the  development  
community and creating tools for utilizing their technology. 
It  made  a  tremendous  amount  of  sense  to  partner  with  
Canonical and begin basing our desktop Linux offerings on 
Ubuntu." 

Linspire will continue combining proprietary drivers, codecs  
and  applications  with  open  source  software  by  default  in 
their operating systems. This approach, unique among Linux  
distributions,  offers  out-of-the-box  support  for  a  broader  
range of software, hardware and multimedia file types than 
the Debian or Ubuntu baseline alone. Linspire will continue  
adding other unique features that are important to its users  
and that make the Linspire desktop Linux easy to use and a  
turn-key solution for OEMs. 

"This technology partnership goes a long way in advancing  
and unifying the Linux desktop," said Carmony. "Linux faces  
many  challenges  as  it  competes  in  a  world  historically  
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dominated by Microsoft Windows, so there is plenty of work  
to  go  around  and  we’re  pleased  to  be  able  to  offer  
differentiation and choice, while reducing fragmentation. We 
are very pleased to be working side by side with Canonical to  
integrate each of our technologies for the benefit  of Linux 
users worldwide." 

"The very nature of Free Software development is based on 
sharing and collaboration," commented Mark Shuttleworth,  
founder  of  Ubuntu,  "The  less  time,  energy  and  resources 
Canonical and Linspire spend duplicating efforts, the more  
time we'll all have for unique improvements and innovation.  
We're  pleased  to  see  another  key  Linux  distribution 
incorporating our work with Ubuntu." 

In addition, Ubuntu users  will  gain access to the Linspire 
CNR e-commerce and software delivery technology. Linspire  
recently  announced  plans  to  make  their  CNR  technology 
available for  other  Linux  distributions  in  addition to  their  
own Linspire and Freespire offerings. Today's announcement 
confirms  that  Ubuntu  will  be  the  first  distribution  to  be 
supported. 

Beginning with Ubuntu’s 7.04 release in April of this year,  
Ubuntu users will be able to use the CNR client to download  
and  install  commercial  programs  and  proprietary  media 
drivers with one click of the mouse. In the future, Canonical  
plans  to  integrate  aspects  of  the  CNR  technology  so  the 

purchase  of  commercial  software  is  straightforward  for  
desktop users. 

"Over  the  past  few  years,  Linspire  has  refined  their  e-
commerce and software delivery technology with their CNR 
service," continued Shuttleworth. "For some time, we've been 
planning  enhancements  to  Ubuntu's  commercial  software 
management, and it was only natural to take advantage of  
Linspire's new, open CNR technology rather than duplicating 
that work.” 

Ubuntu users will continue to have the same repository and 
installation  options  as  before,  but  will  enjoy  expanded  
capabilities  with  the  incorporation  of  the  new  CNR 
technology features such as access to a range of commercial  
consumer applications, multimedia support and games. 

“This  partnership  will  enable  us  to  provide  commercial  
software products and services such as legally licensed DVD 
and media  players  to  users  who want  them.”  noted  Steve  
George, Director of Support and Services for Canonical. 

For additional information see the FAQ section at

http://www.linspire.com/ubuntupartnership
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About Canonical and Ubuntu

Canonical  Ltd,  the  commercial  sponsor  of  Ubuntu,  is  a  
global organization headquartered in Europe committed to  
the  development,  distribution,  and  support  of  open  source 
software products and communities. World class commercial  
support for Ubuntu is available through Canonical's Global  
Support Services team and partners. 

Since its launch in October 2004 Ubuntu has become one of  
the most highly regarded Linux distributions, with millions of  
users  around  the  world.  Ubuntu  will  always  be  free  to 
download, free to use and free to distribute to others. With  
these goals in mind, Ubuntu aims to be the most widely used 
Linux  system,  and  is  the  centre  of  a  global  open  source 
software ecosystem. 

About Linspire & Freespire

Linspire,  Inc.  www.linspire.com was  founded  in  2001  to 
bring  choice  into  the  operating  system  market.  The 
company's flagship product, the Linspire operating system, is  
an  affordable,  easy-to-use  Linux-based  operating  system 
distributed primarily pre-installed on PCs for home, school,  
and business users. 

Linspire pioneered CNR Technology, which allows Linspire 
users  access  to  thousands  of  software  programs,  each  of  
which can be downloaded and installed with just one mouse  

click. The thousands of software titles available in the  CNR 
Warehouse include full office and productivity suites, games, 
multimedia players, photo management software, accounting 
tools, and more. 

Freespire (www.freespire.org) is a community-driven, Linux-
based operating system that combines the best that free, open  
source  software  has  to  offer  (community  driven,  freely  
distributed, open source code, etc.), but also provides users  
the  choice  of  including  proprietary  codecs,  drivers  and 
applications  as  they  see  fit.  With  Freespire,  the  choice  is  
yours as to what software is installed on your computer, with 
no limitations or restrictions placed on that choice. How you  
choose  to  maximize  the  performance  of  your  computer  is  
entirely up to you. 

About CNR

CNR, is a digital software distribution technology developed  
by Linspire, Inc., which allows desktop Linux users to find,  
install,  uninstall,  manage,  and keep updated,  thousands of  
software programs on their Linux computers,  all  with just  
one click.  Users  also get  a  powerful  way to manage their  
entire  software  library,  with  advanced  features,  such  as 
customizable "aisles" where you can install entire groups of  
software with a single click. 

Index 
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Get more from the State Library

If  you  have  an  active  State  Library  Librarycard  and  an 
Internet connection, you can borrow anything in their lending 
library, no matter where located, and pick it up at your local 
branch.  The  State  Library  will  even  email  you  to  let  you 
know the requested item has arrived. It is only then that you 
need to visit the library – all the rest can be arranged from 
your computer's keyboard.

To select a book, audio book, CD, DVD or other item, you 
log on to the Talis catalogue. If you are not familiar with how 
to use the catalogue,  place requests ('holds')  on items you 
require, and send yourself details of items you might want to 
borrow  in  the  future,  then  take  the  online  tutorial  (URL 
below) or consult your local branch about what training they 
offer.  Most  branches  have  regular  sessions,  whilst  others 
offer training sessions when there is sufficient demand.

http://www.statelibrary.tas.gov.au/talistutorial/default

A few tips for those who know how to use Talis:
 
• To browse, say, all the DVDs they have, simple do a 

search for 'DVD'  using the  All words option. This 

works  because  DVD is  given as  a  Format in  the 
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Figure 6: The Talis Simple Search window

Figure 7: Refining the search by adding criteria

http://www.statelibrary.tas.gov.au/talistutorial/default


details  of  the  titles  they 
have  and  you  can  search 
for  any  word  in  the  full 
details.

• To  check  only  newer 
items  (e.g.  recently 
published  computer 
books)  set  the  Date 
criteria to '2006-2007'.

Whilst  I  couldn't  work  out  search 
criteria to limit  the search only to 
computer  books,  I  found  this 
procedure produced good results:

• Using  Title/Series 
as  the  option,  enter, 
say,  'dummies'  and 
click  Submit 
Search.  See  Figure 
6.

• When the results are 
displayed,  click 
Refine  Search, 
choose  OR and 
enter, say, 'complete 
idiot's' and  again 
click  Submit 
Search.  See  Figure 
7.
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Figure 8: The Saved Records list includes items on order but not yet in the Library.



• Repeat for other series – up to about 8 criteria can 
be added in this way. You might also use words 

like “computer” or “Firefox” to add to the search.
• Although non-computer books from these series 

will be included in the results, you should end up 
with a list of no more than about 90 books.

• Go through the list and tick the titles you think 
you may be interested in.

• Click  on  Show Saved to  display  your  selected 
titles.  You'll  see  a  summarised list  of  the  titles 
you have chosen. See Figure 8.

• Email this  list  to  yourself.  Instead  of  the 
summary,  you  will  receive  is  an  expanded  list 
giving the full details of each title. You can also 
print it out.

• Some items on the list may only be on order and not 
yet  available  from the  State  Library.  You  cannot 
place a Hold on these. Use Talis to check back from 
time to time and see if they have arrived. 

• To place a Hold on a particular item you need to go 
back to the Search Results and then go to the Full 
Record.  You'll  need  to  have  your  librarycard  and 
password handy.

• Should you change your mind about an item, you 
can use Talis to cancel the Hold.

New arrival RSS feeds

Another service the State Library offers is news feeds giving 
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Figure 9: Sage extension of Firefox reads RSS feeds



the latest arrivals. With these you can keep up with the latest 
books,  magazines,  graphic  novels  (comics),  CDs,  DVDs, 
videos and many more items that the library has to offer.

RSS feeds are an easy way to see updates of new contents 
from your favourite websites.  If  you subscribe to the State 
Library of Tasmania's New Arrivals RSS feed, you can learn 
about  their  New  Arrivals  the  instant  they  update  their 
webpage.  The  new information  is  collected by newsreader 
software and called an RSS feed.

There are two ways to receive the State Library RSS feed, 
either via a newsreader (or your web browser) or via email. I 
found the  simplest  way was  to  add  the  Sage  extension  to 
Firefox. With this you can open the RSS feed list in the left 
hand column and read it in the right. See Figure 9. 

If you prefer to be notified by email, you need to sign up to a 
service which will take the library's RSS feeds and convert 
them  in  to  emails  for  you.  Some  free  examples  of  such 
services are Squeet  and Feedblitz.  (http://www.squeet.com; 
http://www.feedblitz.com) The State Library link you need is 
http://www.statelibrary.tas.gov.au/newarrivals. 

For more information on the State Library's New Arrival RSS 
feeds, ask at your local branch for their brochure which will 
give you details of how to use the service.

Index

Linux Peugeot?

It used to be Linux Penguin, but, perhaps, the Peugeot should 
become the new logo. Or maybe the Citroen. Certainly Linux 
desktop  advocates  have  reason  to  thank  PSA  Peugeot 
Citroen, which recently announced that it would roll out 2000 
Novell SUSE Linux desktops and 2500 SUSE servers over 
the next several years.

At this stage, there is little information available about just 
how  the  company  plans  to  use  Linux,  but  observers  are 
calling the planned rollout one of the largest Linux desktop 
projects ever by a private enterprise. Peugeot Citroen says the 
ease of use, interoperability with Windows operating systems 
and  applications,  and  Novell's  support  offerings  were  the 
reasons  it  went  with  the  open  source  desktop  and  server 
technology. 

Also  from  France  comes  the  news  that  the  French 
Parliament's offices are to do a desktop swapout, replacing 
Windows with Linux. 1154 desktops are involved.

Novell's website lists organisations in China, Brazil, Europe 
and  the  US  that  have  adopted  Linux  solutions  and  the 
company is pushing hard to get Linux considered instead of 
Windows Vista.

Index 
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Hot tips for Windows users

Here's  ten 
useful  tips  for 
Windows  XP 
and  Microsoft 
programs, cour­
tesy  of 
Conquer  Your 
Computer by 
Ms  Megabyte, 
which is one of 
the many useful 
titles  available 
from  the  State 
Library.  (See 
our  article 
elsewhere  for 
more  inform­

ation on reserving books and having them transferred to your 
local branch.)

1. To rename files when working with My Computer 
or Windows Explorer, press F2, type the new name 
and press ENTER.

2. If you need to put a screen dump into a document, 
click on the window that you want to dump, press 
ALT and Print Screen together, switch to your 

document and use Paste (CTRL + V) to paste it in.
3. In Microsoft Office XP and 2003, there is a task 

pane which is a handy way to access the ClipArt 
Gallery, Styles and Formatting. Just press CTRL + 
F1 to open it.

4. When working with graphics in MS Office, if you 
'lose' an object in a stack, click on a visible object 
and press Tab or Shift Tab to cycle through the 
objects in the stack. When the object you want is 
selected, use the Arrow Keys to nudge it out from 
behind the other object.

5. The right mouse button brings up what we call a 
'context sensitive menu' – that's a menu relevant to 
what you are doing. For example, if you right click 
on a table, you'll get the table options; right click on 
a piece of text to get the text formatting options; 
and so on. This right click for a context sensitive 
menu applies right throughout your Windows 
system, with only an occasional exception. Learn to 
use it; it makes life a lot easier.

6. In an Excel spreadsheet, if you have columns 
headed by dates (e.g. 2000, 2001, 2002 etc.) leave a 
blank row below them. This aids readability and 
prevents Excel from including them in automatic 
calculations.

7. In Powerpoint you can start a slide show from slide 
1 no matter what slide you are currently viewing, 
by pressing F5.

8. In Internet Explorer, if you want 
http://www.mmaca.com, for example, just type 
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mmaca and press CTRL + ENTER. (This works 
for .com websites only.)

9. To select a large block of text, left click at the 
beginning of the text and use the scroll bar to scroll 
down to the end of the text you wish to select. Hold 
the Shift key and click at the end of the text to 
select the whole block.

10. If you want to send an email to a large group of 
people, do not use CC:, instead use BCC: for the 
list of people it is to go to and address the message 
in the TO: line to yourself (or leave that line blank). 
That way, there is no long list of addresses at the 
start of your message and your friends won't get 
upset about their addresses being put at risk of 
spamming. In Outlook Express you may need to 
click on View and select All Headers to make BCC: 
visible.

Conquer Your Computer is a spiral-bound book that lies flat 
beside your computer making it easy to follow the step-by-
step instructions that 'Ms Megabyte' gives. 

Topics covered include Windows, Word, Excel, Powerpoint,  
Internet, eBay, Email (Outlook), Digital Photos, and what to 
do  when  things  go  wrong.  The  book  is  well-written  and 
highly  recommended  for  anyone  using  Windows and 
Microsoft applications.

Index

The case against Vista

Our esteemed President forwarded me a well reasoned and 
researched document that outlines some problem areas with 
the new Windows Vista.  The  document  is  far  too  long  to 
reproduce here, but here's the author's summary:

Windows Vista includes an extensive reworking of core 
OS elements in order to provide content protection for so-
called “premium content”, typically HD data from Blu-
Ray  and  HD-DVD  sources.  Providing  this  protection 
incurs considerable costs in terms of system performance,  
system  stability,  technical  support  overhead,  and 
hardware and software cost. These issues affect not only  
users of Vista but the entire PC industry, since the effects 
of the protection measures extend to cover all hardware  
and software that will ever come into contact with Vista,  
even  if  it's  not  used  directly  with  Vista  (for  example  
hardware in a Macintosh computer or on a Linux server).  
This  document  analyses  the  cost  involved  in  Vista's  
content  protection,  and the  collateral  damage that  this 
incurs throughout the computer industry.

You'll find the full, freely distributable document at:

http://www.cs.auckland.ac.nz/~pgut001/pubs/vista_cost.html

Index
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Other Vista opponents

The Free Software Foundation (FSF) has launched a website 
called  BadVista.org,  which  is  a  campaign  with  a  twofold 
mission of exposing the harms inflicted on computer users by 
the  new  Microsoft  Windows  Vista and  promoting  free 
software alternatives that respect users' security and privacy 
rights. 

“Vista  is  an  upsell  masquerading  as  an  upgrade.  It  is  an 
overall  regression  when  you  look  at  the  most  important 
aspect  of owning and using a computer: your control  over 
what it does. Obviously MS Windows is already proprietary 
and very restrictive, and well worth rejecting. But the new 
'features' in Vista are a Trojan Horse to smuggle in even more 
restrictions. We'll be focusing attention on detailing how they 
work, how to resist them, and why people should care”, said 
FSF program administrator John Sullivan. 

The  campaign  will  organise  supporters  into  effective  and 
unusual  actions  drawing  attention  to  this  daylight  theft  of 
computer users' rights, aggregate news stories cutting through 
the Vista marketing propaganda, and provide a user-friendly 
gateway to the adoption of free software operating systems 
like gNewSense (http://www.gnewsense.org). 

Peter  Brown,  executive  director  of  the  FSF  said,  “Whilst 

Microsoft embarks upon its largest ever product launch, its 
marketing dollars will be spent in an effort to fool the media 
and user community about the goals of Vista. Our campaign 
will ask the important questions. Can you set yourself or your 
company free? Can you ever be free from Microsoft? As with 
our campaign against  Digital Restrictions Management,  we 
aim to demonstrate that technologists can be social activists, 
because we know the harm that Vista will cause”.
 
Among other harms, BadVista.org will focus on the danger 
posed by Treacherous Computing in Vista. Commonly called 
Trusted Computing in the industry,  it  is an attempt to turn 
computers  from  machines  controlled  by  their  user  into 
machines  that  monitor  their  user  and  refuse  to  operate  in 
ways that manufacturers don't authorize. 

Supporters  can  sign  up  to  receive  more  information  and 
participate in the campaign at http://badvista.org.

Further criticism of Vista's Digital Rights Management was 
published in Australia's APC magazine, alleging that Vista is 
defective by design.

http://apcmag.com/5348/vista_defective_by_design

Whatever  you  feel  about  these  arguments,  you  owe  it  to 
yourself at least to examine them before committing to Vista.

Index 

15

http://apcmag.com/5348/vista_defective_by_design
http://badvista.org/
http://www.gnewsense.org/


Ten reasons to get Vista

And just to show we do occasionally present both sides of an 
argument, here's ten (edited) reasons why you might consider 
getting Vista (Dan Warne, APC magazine):

Here are the real benefits: things that will actually make 
a difference to you day-to-day.

1. UI built for the era of video and digital  
photography
... [P]hotos, videos and music are not treated the 
same as Word documents any more. When you 
open a folder of photos, they come up as they'd 
appear in Google Picasa or Apple iPhoto.  
There's inbuilt basic photo editing. Music folders 
come up in columns of ID3 tags, a bit like 
iTunes. Finally, you don't have to rely so much 
on third party apps to work with your files.

2. Image-based install
... The Vista DVD is actually a pre-installed 
version of the OS in a compressed form, making 
it substantially quicker to install. It's also much 
easier to customise for unprompted installation 
with the correct defaults, and you can even 
install your own software automatically at the 

time Vista is installed. ...

3. Up-to-date driver base and better driver 
handling on installation
Enjoy the just-baked driverbase while it lasts 
(19,500 drivers large). If you do need to use a 
special disk driver during installation in the 
future it won't have to be on floppy disk. Now 
you can use a USB memory key or CD. Also,  
Microsoft is now making much greater use of  
Windows Update for provision of drivers that  
aren't present in the Windows RTM driver base.  
...

4. Desktop search and search folders built in
... [D]esktop search folders are handy for 
finding stuff you haven't necessarily got stored in 
one folder but that is useful to gather together 
from time to time (e.g. documents with "tax,  
invoice or receipt" in them). 

5. Sleep mode that actually works 
... Vista has finally caught up to operating 
systems that can sleep near instantly and wake 
up reliably, in a couple of seconds. 

6. Rock-solid laptop encryption
The data on your laptop is worth a hell of a lot  
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to an identity thief. Vista's "Bitlocker" encryption 
(only in Enterprise and Ultimate versions) does 
heavy-duty, full-drive encryption, so you can be 
certain that unless a thief has your password 
there's simply no way they're going to get in. 

7. Better file navigation
Vista now has some time-saving features like 
favourite folders displayed in the left column of  
every Explorer window, as well as 
"breadcrumbed" folder lists allowing you to 
quickly jump backward and forward through a 
path. ...

8. Inbuilt undelete
Or, depending on how you look at it, inbuilt  
rolling backup. Every time you make a change to 
a file or delete it, Windows keeps the previous 
version. ... 

9. DirectX10
OK, this isn't so much a benefit as your hand 
being forced: DirectX 10 will never be made for 
XP, and a raft of games have already been 
announced ‘exclusively' for 10. ...

10. Face it, you have no choice
When Microsoft brings out a major renovation to 

Windows, you can choose to ignore it for a year 
or two, but then the device drivers start drying 
up for older versions of Windows, your friends 
start asking questions about their new PC that  
you can't answer, and even if you use Linux, 
you'll inevitably need familiarity with Microsoft's  
latest interoperability blockers. Face it: your 
arse belongs to Redmond.

Source: http://apcmag.com/5082/10_reasons_you_should_get_vista

This is just part of an on-going discussion. For an unedited 
version of the above, reasons not to get Vista, and rebuttals of 
the above reasons to get it, follow these links:

http://apcmag.com/5049/10_reasons_not_to_get_vista

http://cogscanthink.blogsome.com/2007/01/21/538/

http://apcmag.com/5097/in_response_to_10_reasons_not_to_get_vista

In  the  final  analysis,  there  is  much  that  is  new  in  Vista, 
including  the  controversial  DRM,  but  only  you  can  judge 
whether you need the new features, or whether it is better to 
wait until  the inevitable upgrades and patches are issued – 
SP1 or even SP2.

Eventually, though, if you use Windows, you will probably 
end up with Vista.

Index 

17

http://apcmag.com/5097/in_response_to_10_reasons_not_to_get_vista
http://cogscanthink.blogsome.com/2007/01/21/538/
http://apcmag.com/5049/10_reasons_not_to_get_vista
http://apcmag.com/5082/10_reasons_you_should_get_vista


Extend Vista activation deadline

Ever  since  Windows  XP was  introduced,  products  from 
Microsoft  and other  vendors have required "activation".  In 
Microsoft's case the trial period is 30 days after which the 
product  loses  some,  or  all,  of  its  functionality.
After installing Windows XP or Vista, you have the usual 30-
day "trial  period" before you need to activate the product. 
You  can  do  so  by  allowing  the  software  to  contact 
Microsoft's servers via your Internet connection. If you don't 
have  Internet  access,  or  prefer  not  to  use  an  automated 
process,  you can call Microsoft to receive a code to enter on 
your keyboard.

An activated  copy of  Windows is  "locked"  to  the  specific 
configuration  that  was  present  at  activation  time  –  the 
particular  motherboard,  hard drive,  and so forth.  Changing 
several components, such as during a hardware upgrade, can 
require reactivation. If the automated process fails you need 
to  ring  the  Microsoft  number.  If  you  follow the  direction 
carefully,  you  will  end  up  with  an  activation  number 
consisting of blocks of six digits. Enter them and reactivation 
should occur.

If,  however,  the  automatic  telephone  process  fails  –  and, 
when there has been a major upgrade, it often will – you will 
be put through to an operator. Microsoft seems to be liberal 

about  providing  new  activation  codes  to  anyone  who 
provides a plausible explanation, provided that the particular 
product has not been activated several times. Activating by 
phone usually does not take very long.

All versions of Vista allow a 30-day period without activation 
(except  the  corporate-oriented  Vista  Enterprise,  which 
supports only a 3-day trial). If you know the secret, however, 
you can extend the activation deadline of  editions such as 
Vista Home Premium and  Vista Business up to four months 
past the original install date.

If you have a good reason for needing a longer trial period, 
read the following Windows Secrets (incorporating Langalist) 
explanation of how you can alter the trial period. 

http://windowssecrets.com/comp/070215

Windows Secrets incorporated the former Langalist last year 
and  is  dedicated  to  providing  “Everything  that  Microsoft 
forgot to mention”. To subscribe, simply go to their website 
and enter  your email  address.  Windows Secrets undertakes 
never to sell,  rent  or  give away you address to  an outside 
party,  never send you unrequested email and to honour all 
unsubscribe  requests  immediately.  You've  nothing  to  lose. 
Subscribe now and regularly receive well research tips to get 
more out of Windows.

Index 
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Personalising Firefox

Firefox, as first installed, does not try to be all things to all 
people. That keeps it lean, mean and fast. It also means that 
there are additions that individual users would like to add. 
Rather  than  bulk  Firefox  out,  the  designers  provided  a 
mechanism so that you can "brew your own". Thousands of 
extensions  have  been  written  to  take  advantage  of  this 
mechanism and I intend to describe just a small selection of 
them here to give you an idea of their scope. To begin most 
reviews I have quoted the developers' claims.

In  choosing  what  to  add  to  your  copy of  Firefox,  try  the 
Recommended  Add-ons,  or  the  following  suggested 
extensions, most of which I use myself on a regular basis.

Extensions

Answers

Alt-Click  on  any  word  or  term  for  quick  information 
(definitions,  up-to-the-minute  reference  and  more).  No 
selection is necessary.

Depending  on  your  operating  system and  preferences,  you 
may  need  to  use  another  key  combination.  Mine  is 
CTRL+right click.

When  you  click  a  "balloon"  opens  (or,  if  you  prefer,  the 
whole screen can be used) and a definition of your chosen 
word appears. 

This  extension  works  well  with  broadband,  the  faster  the 
better,  but  would be less useful  on a dialup system as the 
definitions would take longer to fetch.

Bookmark synchronisation

By uploading your bookmarks to a website, you can then pass 
them  to  another  computer,  operating  system  or  browser. 
There are a number of extensions for Firefox that can handle 
synchronisation for you, including Del.icio.us and Foxmark. I 
use  the  latter,  which  offers  the  opportunity  to  merge  or 
overwrite bookmarks, working in either direction.

Cooliris Previews

Cooliris  Previews  is  a  free  browser  add-on  that  lets  you 
preview links without clicking or leaving your current page.  
Now you can browse faster than ever.

You can preview
Search results
Bookmarks on Del.icio.us
Videos on YouTube

19



Photos on Flickr

When  you  point  to  a  link  to  preview it,  Cooliris  opens  a 
window for the preview. You can keep this window open, 
send the link to someone else, or open the link in a new tab in 
Firefox.

Again  this  is  an  extension  that  is  only  really  suitable  for 
broadband use.

Dai.sy

In 3 Easy Steps:
1. You and some friend (s) add the Dai.sy extension to 

your Firefox Browser
2. Choose a webpage or website for everyone to meet  

at
3. Click  on  the  Dai.sy  icon  located  on  your  main  

browser bar.

Now that you are together, here is how to:

MEET

1. Enter any Nickname you wish to use for this session
2. Choose  one  of  our  pre-made  avatars  or  use  any 

image off your pc
3. Create a topic you wish to discuss (this is optional)

4. Click on the "Enter Chat" button and that is all

SHARE

1. Click the "Choose" button to browse your PC for  
any folder you wish to share with your fellow site  
visitors

2. Click on the "Open Shared Space" button to view to  
all the files the other site visitors are sharing. For
easier browsing, you may Search and Sort the files

3. Double Click on the file you wish to download
4. Choose  a  Destination  folder  by  clicking  the  blue  

folder Icon on the right.
5. Click  the  "Start"  button.  The  progress  of  your 

downloads and uploads can are seen in the status  
windows.

BLOG

1. Click on the "add new" button
2. Enter a Title,  Author Name, Author e-mail  and A  

Password so that only you may edit it in the future.
3. Blog Message: Choose a font type, color and size.  

Add  any  MEDIA  (Image  or  Video)  you  wish  by  
simply  pasting  the  web  address  of  your  chosen 
media file.

Dai.sy's  developers originally announced that  Dai.sy would 
be  available  for  Opera  and  Internet  Explorer  7  by  now. 
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Checking  with  their  website,  I  was  unable  to  find  any 
mention of browsers other than Flock and Firefox. It looks as 
if plans for other browsers have been put on hold.

Download Statusbar

Download Statusbar is a browser extension that allows you 
to keep track of ongoing and completed downloads in a hide-
away statusbar.

Instead of a download window opening, Download Statusbar 
adds information to the status bar at the bottom of the Firefox 
window.  This  enables  you  to  track  downloads  while 
browsing, without having to switch back and forth between 
what you are browsing and the download window.

A neat extension that will suit many people.

DownThemAll (dTa)

The first and only download manager/accelerator built inside 
Firefox!

DownThemAll  is  all  you  can  desire  from  a  download 
manager: it features an advanced accelerator that increases 
speed up to 400% and it  allows you to pause and resume  
downloads at any time!

DownThemAll  is  fast,  reliable and easy-to-use!  It  lets  you 
download all the links or images contained in a webpage and 
much  more:  you  can  refine  your  downloads  by  fully  
customizable criteria to get only what you really want!

DownThemAll  is  absolutely  freeware and open-source.  No 
Adware, no Spyware.

When you install the extension, dTa is added to the Tools 
menu, appearing as an option whenever you right click on a 
link, or click on a file to download.

FireFTP

FireFTP is  a  free,  secure,  cross-platform FTP client for 
Mozilla Firefox which provides easy and intuitive access to  
FTP servers.

Along  with  transferring  your  files  quickly  and  efficiently,  
FireFTP  also  includes  more  advanced  features  such  as: 
directory comparison, syncing directories while navigating, 
SSL encryption, file hashing, and much more!

You  don't  need  a  separate  application  to  handle  FTP 
transfers.  This  small  add-on  turns  Firefox  into  an  FTP 
program comparable with WS_FTP and CuteFTP.
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Forecastfox

Forecastfox is  an  extension  that  brings  international 
weather  from  AccuWeather.com® to  your  Firefox  web 
browser. ... you can easily find your town or city by using the  
built  in  search tool.  It  is  unobtrusive and  lightweight,  yet 
can  be  customized  to  display  nearly  as  much data  as  the  
leading desktop weather programs! If you can't find what you  
are looking for, click the weather icons displayed to open the 
AccuWeather.com® forecast  for  your  location.  A  slider,  
similar to when popup notification for when all downloads  
complete,  pops  up  from  the  bottom  right  corner  of  your 
screen  when  the  current  conditions  are  updated.  You  can  
even set what appears in it or disable it!

There's not much I can add to that. Forecastfox works well 
and  can  be  customised  to  your  locality  and  information 
requirements.

Gspace

The Gspace extension allows you to use your surplus Gmail 
space to store files.  It  is  strictly an unofficial extension of 
Gmail and is not guaranteed to work with future versions of 
Gmail.

GUtil!

GUtil!  adds  a  drop-down  menu  to  the  main  toolbar  of 

Firefox. The menu lists all of the many Google Utilities and 
allows  quick  access  to  your  Gmail  account,  your  Google 
website and to Google online applications, such as Docs & 
Spreadsheets and Notebook.

It is probably worth adding just so that you are aware of all 
that Google offers. Clicking any item in the list will take you 
straight to a page providing you with information about that 
item.  After  you  have  examined  the  full  list  of  around  41 
items, you can use Options to tailor it to show only those that 
interest you.

IE Tab and User Agent Switcher 

There are still a few poorly designed websites that insist you 
must have Internet Explorer. These can be fooled by having 
Firefox identify itself as Internet Explorer. This can be done 
using User Agent Switcher, which works with all versions of 
Firefox, including Linux versions.

However,  there are also a few websites that actually won't 
work  without  ActiveX controls  or  other  features  that  only 
come with Internet Explorer. By adding IE Tab to Firefox, 
you need never look at Internet Explorer again. Simple add 
the website to the list held by IE Tab and whenever you visit 
that site, it will use Windows inbuilt Internet Explorer engine 
to open the site in a Firefox tab. Because it uses Windows to 
accomplish the trick, Linux users will have to start Internet 
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Explorer  to  visit  these  sites.  As  Internet  Explorer  6  runs 
happily under WINE, you don't have to reboot into Windows 
to do this.

Jajah Web-Activated Telephony

JAJAH lets you make free or very low cost global telephone  
calls  directly  from  Firefox  using  your  regular  mobile  or  
landline  phone.  No  headsets,  microphones,  special  
equipment, or fees are required.

With the Jajah extension, you type the number you want to 
call in a panel in the main toolbar (or wherever you choose to 
relocate the panel to), your phone and the call number ring 
and  you  talk  to  the  called  party  over  your  normal  phone 
system,  while  enjoying  free  and  low  cost  calls  over  the 
Internet.

ReminderFox

ReminderFox is  an extension for  Firefox and Thunderbird 
that displays and manages lists of date-based reminders and  
ToDo's.  ReminderFox  does  not  seek  to  be  a  full-fledged 
calendar system. In fact, the target audience is anybody that  
simply  wants  to  remember  important  dates  (birthdays,  
anniversaries,  etc)  without  having  to  run  a  fat  calendar 
application. 

Here's Ian Smith's review:

I'm  somewhat  of  a  productivity  zealot  and  I  love  any  
application  that  helps  me  stay  on  task.  Reminder  Fox  is  
designed to do just that. One of the better Firefox extensions  
I've found, Reminder Fox sits quietly in the bottom left corner  
of the browser and lets you manage a to do list and schedule  
reminders.

There are two tabs on Reminder Fox: Reminders and ToDos. 
When you schedule a reminder you can give it a description,  
a date, a time (reminders can also be all day events), and a  
priority. You can also schedule a reoccurring reminder and 
have  the  application  alert  you  daily  until  you  complete  a  
task. It even provides a calendar so adding items is as simple 
as double clicking the day in question. All  within Firefox!  
This is a very simple and slick way to remind myself to feed  
the office fish Mondays, meet my wife for lunch Wednesdays,  
get that report done by Friday, etc.

The ToDo tab is much the same. You can still set a date for a  
ToDo item if you wish, but there is no reoccurring feature.  
You can view all your to do items together and move them  
around as needed. Once you complete an item it is crossed 
off the list.

Scrolling over the knot in the bottom corner of the browser 
will pop up a tool tip showing you what you have scheduled  
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for the day. You can even view your entries as HTML which 
can be useful for exporting, etc.

For the power user ReminderFox has a ton of options to help  
you customize the application. Almost every default value or  
behavior of the tool is changeable. You can also add more  
tabs (so you aren't limited to Reminder and ToDos but you  
could also have a Home To Do List, for example). You can  
even save all the data to an FTP Server for backup purposes  
or to sync your Reminders across computers.

ReminderFox is  an  excellent  replacement  for  Outlook  and 
online reminder systems and is so light weight you'll hardly  
notice it is there. Go get it!

Sage

Sage is a lightweight RSS and Atom feed reader extension for  
Mozilla Firefox. It's got a lot of what you need and not much 
of what you don't.

What does Sage do?

• Reads RSS (2.0, 1.0, 0.9x) and Atom feeds 
• Newspaper feed rendering customizable via style 

sheets 
• Feed Discovery 
• Integrates with Firefox's bookmark storage and 

Live Bookmarks 
• Imports and exports OPML feed lists 
• Technorati and RSS search engine integration 
• Support for a number of locales ...
• Simple, one step install / uninstall 

RSS (Really Simple Syndication) is a syndication format that 
was developed by Netscape in 1999 and became very popular 
for aggregating updates to blogs and the news sites. RSS has 
also  stood  for  "Rich  Site  Summary"  and  "RDF  Site 
Summary." With an RSS feed you can keep up-to-date with 
such information as the latest releases at the State Library and 
with Sage as your RSS readers, you can do so from within 
Firefox.

There  are  other  RSS  readers  for  Firefox  and  also  for 
Thunderbird. It  is just a matter of choosing what suits you 
best.

Web Search Pro

Firefox comes with Web Wearch built in. You can add many 
search engines from the MyCroft database to the search bar. 
Web Search  Pro  is  an  improved  version  that  can  be  used 
with, or instead of, the standard web search.

Search engines are divided into categories, or you can browse 
the full list, which shows how many times a particular engine 
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has  been  selected  and  when  the  entry  was  last  updated. 
Currently there are 2300 search engines to choose from ( ... 
and counting.)

Themes

You can also personalise Firefox by adding different themes 
to change its appearance. Just go to Tools/Add-ons and click 
the Themes tab. In the bottom corner of the Themes window 
click  on  Get  Themes  and  make  your  selection  from  the 
dozens available.

A personalised Firefox

Firefox can be much more than just another web-browser. It 
can double as  an FTP application,  an RSS news reader,  a 
reminder  program,  a  VoIP  phone  access  point,  a 
dictionary/encyclopedia,  a  download  manager,  an  Internet 
drive, a chat program, a P2P file swapping program and a 
blogging  program.  You  can  search  with  thousands  of 
specialised search engines, even rolling you own combination 
(Rollyo), synchronise bookmarks with other computers and 
browsers and preview pages without leaving the one your on.

And all of that is in addition to the great standard features it 
offers,  such  as  tabbed  browsing,  anti-phishing  and  scam 
warnings, full printing control, and text size adjustment using 
your mouse's scroll wheel. 
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Random floppy drive seeking

Julia  sent  us  an  email  about  a  friend's  computer  which 
searched  for  its  floppy  drive  when  booting  and  again  at 
random intervals whilst he was working on the computer.

The  initial  search  could  be  the  result  of  a  CMOS setting. 
Some  people  find  that  a  floppy  seek  whilst  booting  is 
reassuring. It  certainly is  if  you have had the computer  in 
pieces and want to be sure you have the floppy cable in right. 
The  random searches  are  more  difficult  to  resolve.  Here's 
some  suggestions,  thanks  to  the  various  people  who 
responded to Julia's query and to some further research using 
our old friend Google (which led to Annoyances.org).

• Try putting a blank floppy disc in the drive. It may 
give you an error message that will provide a clue to 
what is going on.

• With Windows ME and later, try a System Restore 
if the problem has only started recently. Choose a 
time when it was not a problem and restore the 
computer to that time.

• If you have MSOffice, disable Find Fast by running 
the Microsoft Office Setup program in maintenance 
mode, and removing the Find Fast component.

• Double-click on the System icon in Control panel, 
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choose the Device Manager tab, and delete the 
GENERIC FLOPPY DISK entry from disk drives. 
Reboot and when Windows restarts, it'll re-detect 
the drive. Deleting drives and ports using Device 
Manager followed by a reboot is quite a useful 
technique when there are problems as it forces 
Windows to re-detect the deleted items and reinstall 
their drivers. You may need to have the Windows 
CD handy, in case it's asked for.

• Run a virus scan. Some reports suggest the 
NEUVILLE virus may be a part of the problem.

• Run a spyware scan with, say, Ad-aware.

• Clear the documents menu. It may contain a 
reference to a file that you have saved to a floppy 
disk that a program you are currently using tries to 
access.

• Clear unwanted entries from the Start Menu's Run 
command. I'm not sure why this would work, but 
http://www.annoyances.org recommends it.

• Search your hard disk for all .PIF files that point to 
programs on a floppy drive. Another tip from 
Annoyance.org. 

• Take out LocalLoadHigh=1 from your 
MSDOS.SYS file. These sort of memory 
management tricks are usually not needed with 
Windows 9x which does its own memory 

management. Where individual DOS programs have 
special requirements, these can usually be set up by 
configuring that program only.

• Check HKEY_CLASSES_ROOT/CLSID in the 
Registry for any references to OCX's or DLL's 
referenced on the floppy. Back up the Registry (see 
Registry Help) before making changes.

Other programs known to cause this problem (according to 
Annoyances.org: 

• Norton Navigator  –  Clear  Norton Navigator's  Run 
history (or disable the Run history all together), and 
download the bug fix from Symantec. 

• McAfee Antivirus '95 – try disabling the Access & 
Shutdown options in the Scan Disks On area in the 
Detection tab of the Configuration Manager. 

• FirstAid  '95  –  try  removing  this  program  or 
disabling certain features. 

• Long Filenames for Windows 98 – View Software 
has a patch that supposedly fixes this problem. 

• HiJack  for  Windows  98  –  turning  off  "Enable 
HiJack  shell  extensions"  in  the  HiJack  Control 
Panel. 

• Remove Konica Picture Show entirely. 
• Norton Antivirus  2000 – turn off  the  options  that 

scan the floppy drive during startup and shutdown. 
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